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1. Preface

The National Levee Database (NLD) is a web-based application created to assist in the dissemination of levee
data. The NLD was created by the United States Army Corps of Engineers (USACE) and serves as the single
source of national flood damage reduction or flood control structures. The purpose of the NLD is to provide a
common database and database structure to allow all levee owners the ability to share and manage levee
information in one common location and one common data structure for Federal Government user including
the USACE and the Federal Emergency Management Agency (FEMA), and non-federal users including state
and local governments, Association of State Dam Safety Officers (ASDSO), the National Association of Flood
& Stormwater Management Agencies (NAFSMA), and the general public.

The user manual is targeted for the Public users and designed to:

1. Provide an overview of the National Levee Database

2. Provide detailed instructions on how to leverage capabilities available in the NLD (e.g. reporting and
mapping interfaces)

3. Improve usage of the NLD tool to improve risk communication, provide transparency and improve
outreach

The document will help orient the users to leverage the following NLD capabilities:

1. Getting Started: How to access the tool, prerequisites, etc.
2. Reports: How to view, customize and export reports

3. Maps: How to utilize the mapping capabilities

4. Feedback: How to submit and view feedback
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2. Getting Started
The Getting Started section provides you with instructions on how to access the NLD.
2.1 Technical Requirements

The NLD is a web-based tool which requires an Internet connection, without the need to install any software.
The initial release of the NLD has been designed for and tested within Internet Explorer version 9. and
Firefox. Other internet browsers should work as well, but are considered unsupported.

To use the NLD, you will need:

1. A computer with an Internet connection

2. Internet Explorer or Mozilla Firefox

3. The NLD can be accessed via the following web site address: http://nld.usace.army.mil

4. Basic levee information can be accessed from the NLD without needing a user name and password.
Users who require access to additional information may request account access and privileges in the
NLD. Account access can be requested by sending an email to DLL-CEERD-NLD-General-
Support@usace.army.mil or calling 1-877-LEVEEUS (1-877-538-3387). User accounts will be
adjudicated by NLD stakeholders. You will receive an email notification regarding your account request

211 Launching the NLD

Launching the NLD involves opening an Internet browser and directing the browser to the NLD web site:
http://nld.usace.army.mil

2.1.2 Launching Internet Explorer Browser

Since the NLD is a web-based application, you must first launch your internet browser, either Internet Explorer
or Mozilla Firefox. There are a number of ways to do this; three of the more common methods are outlined
below.

Method 1: Double-click the “Internet Explorer” shortcut icon on the desktop.

3

Internen
‘5‘16“&[@ 5
Figure 2-1: Internet Explorer Desktop Shortcut

Method 2: Click the “Internet Explorer” or “Firefox” icon in the quick launch menu.

e

Figure 2-2: Quick Launch Menu

Method 3: Select Internet Explorer from the Start menu.
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2 % fe Internet Explorer R
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k\/ Remote Desktop Connection
g

Sticky Notes

C& Snipping Tool
‘... alculator

Figure -3: Start Menu

1. Click the “Start” icon
2. Use your mouse to choose Internet Explorer

2.1.3 Navigating to the NLD

Once the browser window has launched, navigate to the NLD home screen by typing in
http://nld.usace.army.mil as depicted in

Figure 2-4: Internet Explorer Address Bar.

?

'€ ‘v g hhp//nldusacearmymtl | %

File Edit View Favorites Tools Help

Figure 2-4: Internet Explorer Address Bar

1. Enter the appropriate URL in the address bar
2. Click the “Enter” key on the keyboard or click the “Go” button to the right of the address in the browser

2.2 Navigation

Once you have navigated to the NLD you will view the NLD “Home” screen. Before we introduce the details of
this screen it is important to understand the overall layout of the NLD site.
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Figure 2-5: NLD Site Layout
There are five primary components of the NLD site:

1. Banner — Every screen in the NLD Tool will include the banner. You will see the NLD logo and title of
the tool. The banner is static throughout the entire tool and you can use any of its links and buttons from
anywhere within the tool

2. Navigation Toolbar —The banner includes the navigation toolbar. There are six modules accessible from
the navigation tool bar. These modules include: Home, Reports, Maps, Help, About NLD and Contact
Us. This tool bar will be available for you to navigate the tool from any module. No matter where you
are located in the tool if you click on one of these links you will be directed to one of the six modules

3. Feedback & Login — These buttons provide the user the ability to provide feedback on the tool and for
those with an adjudicated account, the ability to login to the tool

4. Primary Content Region — When items on the navigation toolbar are selected this section of the web
page is the primary location where content will be displayed. For instance, if you click “Home” on the
navigation toolbar you will view the Welcome message and Home Portal

5. Page ID/Number — Found at the bottom of each of the NLD web pages, you will notice a number. This
number is unique for each screen
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3. Home
3.1 Home Portal

The NLD Home screen provides a portal-like view to provide users quick-link buttons to navigate the NLD
from one central location. In addition to the quick-link buttons, there are associated tabs displayed on the screen
at the top, left corner of the web page. The “Home” tab contains an introductory welcome message, from here
you may click on the different tabs or quick-link buttons to navigate through the application. An explanation for
each tab and quick-link button is listed below.

National Levee Database

6 %  Feedback ﬁlLogm

Search and view levees Download user manuals !? j
using the interactive map |: quick guides and videos on W

how bestto use the NLD

ENLT o3 A
View presentations, | 777 Please contact us for

documents on the rollout of ﬂ assistance with the NLD.
the NLD
A Please Note: The NLD currently contains the majority of levees within the USACE program. The \

NLD does not contain all levees located in the United States.

10

View searchable reports depicting levee system and segment information

am Rannrtinn Advancad Renaring Find Levees Near Me g

Search for NLD levee data by specified search criteria O\ Navigate through customized reports O | Zip Code I \ a
\ \’ \ 0 Distance miles 13

Submit

Page # 471:1

Figure 3-1: The ‘Home’ Tab

e Reports (1): Allows users to navigate to the Report Store. The Report Store provides multiple options
for users to search, navigate and review levee data within the NLD

e Maps (2 and 7): Allows users to search and view levees using the interactive map

e Help (3 and 8): Provides users access to documentation, including: downloadable user manuals, quick
guides and video tutorials

e About NLD (4 and 9): Provides users information regarding the roll-out of the NLD to include: state,
federal and public events

e Contact Us (5 and 10): Provides email and phone contact information to request assistance from the
NLD help desk

e Feedback (6): Allows users to provide feedback and recommendations to improve the NLD

e Basic System Reporting (quick-link button) (11): Allows users to navigate directly to the Basic System
Reporting tool

e Advanced Reporting (quick-link button) (12): Allows users to navigate directly to the Advanced
Reports

e Find Levees Near Me (quick-link button) (13): Allows users to search for levees in the NLD within a
specified distance from a given zip code

The subsequent sections details the capabilities available for each of the navigation items highlighted above.

30-JUN-2015



NLD User Manual United States Army Corps of Engineers
4, Repo rts
4.1  Navigating to Reports

The “Reports” tab is the second tab available on the NLD navigation toolbar.

es, Maps

Search and view levees using
the interactive map

About NLD

National Levee Database

£ MousiR gFeedoack i Logout

Help

Download user manuals
quick guides and videos on
how bestto use the NLD

(:

Contact Us

Page & 4711

View Please contactus for =
% 7 Lo = % % documents on the rollout of assistance with the NLD. o
A Please Note: The NLD currently contains the majority of levees within the USACE program. The NLD does not contain all levees located in the United | eno
States.
Reports
View searchable reports depicting levee system and segment information
Basic Systen Advanced Reporting = Find Levees Near Me AP
Search for NLD levee data by Navigate through customized reports O | 7ip Code t
\ 2 L—& Distance mile: -
Submit

Figure 4-1: Reports Tab

1. The user can click on the Reports tab to navigate to the interactive map

2. Clicking the “Advanced Reporting quick-link” button will also navigate to the interactive map

By clicking on the “Reports” tab you will be taken to the Report Store screen shown below in Figure 4-2:

Report Store.

4.2 Report Store

The Report Store allows you to choose which method you would like to search and view reports with four

easily navigable options, as seen in Figure 4-2: Report Store.

30-JUN-2015



NLD User Manual United States Army Corps of Engineers

Report Store

Basic System Reporting
Search for NLD levee data by —
specified search criteria 1

Advanced Reporting
Navigate through customized —
reports

Map Query Reporting

Search for a specific location or —
address to view levees located 3
near them using the map I

Find Levees Near Me

)| @ [0l O

Identify specific levees within a —1 G =
specified distance from a given 4 K
ZIP code N
— N5
—

Figure 4-2: Report Store

=

Click the “Basic System Reporting” icon to search for NLD levee data by predetermined search criteria

Click the “Advanced Reporting” icon to navigate through customized reports

3. Click the “Map Query Reporting” icon to search for a specific location or levee feature on the map to
query in order to view levee data

4. Click the “Find Levees Near Me” icon to easily enter a zip code and distance in which to search for

levees

no

4.3  Basic System Reporting

Basic System Reporting interface allows a quick and easy search for NLD levee data by specified search criteria
such as: State, County, FEMA region, Organization, PAL status (Provisionally Accredited Levee),
Authorization Category, and RIP status (Rehabilitation and Inspection Program).
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Welcome to the National Levee Database
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Here is what is available in the NLD:
« Majority of levees located within the USACE Levee Program
« Reports on levees in the NLD located within your state, zip code, or address
* Various | database resources integrated into NLD such as the National Weather Service
« Feedback link for you to provide comments on the NLD
« Contact Us tab if you need assistance or have questions

LU Reports Maps Help AboutNLD ContactUs

National Levee Database

.o Feedback | Login

Maps
Search and view levees
using the interactive map

Help
Download user manuals,
quick guides and videos on

((L: how bestto use the NLD fé

About NLD

View presentations,
on the rollout of

A Please Note: The NLD currently contains the majority of levees within the USACE program. The
NLD does not contain all levees located in the United States.

Reports

Contact Us =
Please contact us for =
assistance with the NLD. |~

|

the NLD

View searchable reports depicting levee system and segment information

Basic System Reporting
Search for NLD levee data by specified search criteria

AN

Advanced Reporting Find Levees Near Me ‘/'\
Navigate through customized reports O Zip Code | ‘ j
% —X Distance miles -
Submit

Page # 471:1

Figure 4-3: Basic System Reporting

1. Click the “Basic System Reporting quick-link’ button to search for NLD data by predetermined search
criteria

LI Reports

Basic System Reporting
T states - Add State - v © add state
California @ Remove State
County Sacramento County v
G}/ FEMA Region Any v
G Organization SACRAMENTO  +
Status Any

3

orzation Category ANY

@Ay ®Active ) Inactive
i S ©MNotEmolled  ©)Not Eligle @) NA
Submit  Clear  Return to Report Store
3 T~
/ 5
l jzation System Name(v) State(s) Cong. District  County(ies)
“, SACRAMENTO Upper Morison | Califonia California- 05 Sacramento
/ Creek County
“*, SACRAMENTO  Union House-Elder  California California- 05 Sacramento
d Creek County

Maps Help AboutNLD Contact Us

[ h
v [}
v
FEMA Length Link Inspection Inspection  Risk
e Segment(s) (Mies) Mlgp e Inspection Rating i e Authorization Category
Region 128378 @ Routine  MINIMALLY 09-AUG-06 No  |USACE Federally
109 ACCEPTABLE Constructed and USACE
Federally Operated
Region 3 2.9462 e - No Locally Constructed,
09 Locally Operated and

Maintained

1-220f22
Corps
Authorization Type Program Sponsor(s)
Levee
USACE Federally Constructed and USACE Yes City Of Sacramento
Federally Operated
|Federally authorized to be in USACE program, ~ |Yes lCi!y Of Sacramento

|Federally Operated

National Levee Database

o Feedback | Login

locally operated and maintained, Non-federally
constructed, operated and maintained by locals,
USACE Federally Constructed and USACE

Figure 4-4: Basic System Reporting

2. Use the dropdowns to specify State, County, FEMA Region, Organization, PAL Status, and
Authorization Category. Use the radio buttons to specify a RIP Status. To select the State, you need to
press the green “+” icon. After selecting and adding a State, a County dropdown will appear to further

define your search

3. Click the “Submit” button to view results
4. Click the “Clear” button to clear the search criteria and run a new report

8
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5. Click the “Return to Report Store™ button to view Report Store reporting options

4.4  Advanced Reporting

The Advanced Reporting screen allows the user to create a more customizable report. View the Interactive
Reports Primer to learn about the different reports and advanced reporting features, or choose a report to view

and customize, as seen in Figure 4-6: Advanced Reporting.

A
US Army Corps of Engineers

Welcome to the National Levee Database

The National Levee Database (NLD), developed by the U.S. Army Corps of Engineers (USACE), is the focal point for comprehensive information about our nation's levees. Authorized by
Congress in 2007, the database contains information to facitate and ink activties, such as flood risk communication, levee s
(NFIP), levee system flood plain and risk
agencies, states, and tribes

em evaluation for the National Flood Insurance Program
The NLD continues to be a dynamic database with ongoing efforts to add levee data from federal
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Majority of levees located within the USACE Levee Program

Reports on levees in the NLD located within your state, zip code, or address
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Advanced Reporting
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A}

o

Page # 471:1

Find Levees Near Me

Zip Code |
Distance miles

Submit

Figure 4-5: Advanced Reporting

1. Click the “Advanced Reporting quick-link” button to navigate through customized reports

Army Corps of Engineers

Advanced Reporting

31 Interactive Reports Primer - Guide for using NLD Reports

Return to Report Store

B -ECcategoy 1%
Category : 1 System

| Report Link ‘Summary

Report Name: Help
System Feature Quantity of levee features by levee system System Feature Data Included
LD ledia Wedia information for systems, segments and features NLD Wedia Data Included
System Detail Report providing specific details of each levee system by organization System Detail Data Included
Category : 2 Segment

Report Link Summary Report Name Help
Segment Feature Quantity of levee features by levee segment Segment Feature |Data Included
it Detail P of each levee segment by organization ‘Segment Detail iDa'a Included
Category : 3 Authorization
Report Link Summary. Report Name: Help
Detail Report of each levee auth tion by organization Auth tion Detail |Data Included
Category : 4 Inspection
Report Link Summary Report Name. Help
Segment Inspection  Inspection information (date, rating, file and results) per levee segment  Segmentinspection | Data Included|
System Inspection Inspection information (date, rating, file and resuilts) per levee system System Inspection |Data Included
I
Category : 5 Submission
Report Link Summary Report Name: Help

Levee System Summary Levee System Summary Report by System Levee System Summary | Data Included

evee System Summary Levee System Summary Report by Segment Levee System Summary Data Included

Figure 4-6: Advanced Reporting
9

National Levee Database

o Feedback

(TSl Maps Help AboutNLD Contact Us

5] Login

30-JUN-2015



NLD User Manual

United States Army Corps of Engineers

44.1 Interactive Reports Primer

The Interactive Reports Primer is a PowerPoint briefing that provides an introduction to the “Interactive

Reports” functionality within the NLD.

Reports

Advanced Reporting

Category V] %

Category : 1 System

Report Link Summary
System Feature Quantity oflevee featires by levee system

Meda information for systems, segments and features

Report prowaing specific details of each levee system by organization

Category : 2 Segment

Report Link Summary
Seament Feature Quantiy of levee features by levee segment
Ssqment Detail Report prowiding specific details of ach levee segment by organizaion

Category : 3 Authorization

Report Link Summary
AMozaton Detal  Report prouding specific Getais of each levee authorizabon by organization

Category : 4 Inspection

Report Link Summary
se ction  Inspection information (date, rating, i and results) per levee segment

Inspection information (date. raling, i and results) per ievee system

Category : 5 Submission

Report Link Summary
ary Levee System Summary Report by System

ummary Levee System Summary Report by Segment

Figure 4-7: Advanced Reporting, Interactive Reports Primer

_ ! s
US Army Corps of Engineers

Report Name Heip

System Feature

NLD Media

System Detall

Report Name Heip
included

Segment Feature

Segment Datall

Report Name Help

Aumorzation Detall | DataIncluded
Report Name Help
Segmentinspecton | Data Included
System Inspecson Data Includeg

Report Name Help

Levee System Summary|Data Included

Leves System Summary| Data Ingluded

1-10

National Levee Database

1. Click on the hyperlink titled “Interactive Reports Primer.” The “File Download” pop-up will display as
shown in Figure 4-8: File Download

Figure 4-8: File Download

Opening NLD_Interactive_Reports.ppt

You have chosen to open
2] NLD_Interactive_Reports.ppt

which is a: Microsoft PowerPoint 97-2003 Presentation
from: http://nld.usace.army.mil

What should Firefox do with this file?

2. Click the “Open” radio button to open the file and save to a temporary location on your computer
3. Click the “Save” button to save the document to a specific location on your computer

@ Open with | Microsoft PowerPoint (default)

() Save File

/ [ Do this automatically for files like this from now on.

Figure 4-8: File Download

10
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Click the “Cancel” button to return to the Advanced Reporting screen

National Levee Database

US Army Corps of Engineers  Foedback ] Logn
0 Reports T ——_—.

Advanced Reporting

31| Interactive Reports Primer - Guide for using NLD Reports

Category ] -

Category : 1 System

Report Link Summary Report Name Help.
Sistem Feature uan System Feature
NLD Media e NLD Media
Sistem Detal R of each levee system by organization  System Detall
Category : 2 Segment

Report Link Summary Report Name Help.
Seament Feature Quantiy of evee features by levee segment Segment Feature Data Included

qment Detail of each levee segment by organization | Segment Detail Data Included

Category : 3 Authorization

Report Link Summary Report Name Help.
Authorization Detail | Report providing specific details of each levee authorization by organization Authorization Detail | Data Included
Category : 4 Inspection

Report Link Summary Report Name Help

Seqment inspection  Inspection information (date, rating, file and results) per levee segment | Segment inspection | Data Included

Sustem Inspection  Inspection information (date, rating, file and resuits) per levee system  System Inspection Data Included

Category : 5 Submission

Report Link Summary Report Name Help
Levee System Summary Levee System Summary Report by System Levee System Summary Data Included
evee System Summary Levee System Summary Report by Segment Levee System Summary Data Included
1-10

4. Figure 4-6: Advanced Reporting

National Levee Database
Interactive Reports
Instructions

NLD Point of Contact
DLL-CEERD-NLD-General-Support@usace.army.mil

US Army Corps 1
of Engineers

Figure 4-9: Interactive Reports Primer PowerPoint Presentation

5. The PowerPoint briefing will open in a new web browser window. We highly recommend that you
peruse this document to become better acquainted with the full reporting functionality

4.4.2 Selecting a Report

The reports area of the tool includes a number of predefined reports. Currently there are 8 reports as detailed
below:

11
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o Feedback ] Login

Advanced Reporting

1. System Detail: Report providing specific details of each levee system by organization

2. NLD Media: Report providing media information for systems, segments, and features

3. System Feature: Report providing quantity of levee features (i.e. gravity drains, pump stations relief

wells, boreholes, etc.) by levee system

Segment Detail: Report providing specific details of each levee segment by organization

Segment Feature: Report providing quantity of levee features (gravity drains, pump stations, relief

wells, boreholes, etc.) by levee segment

Authorization Detail: Report providing specific details of each levee project by organization

System Inspection: Report providing levee inspection information (date and rating) by levee system

Segment Inspection: Report providing levee inspection information (date and rating) by levee segment

Levee System Summary (System): Levee System Summary Sheet showing several pages of details on the levee

system. Will only be present of a submitting district has uploaded a sheet for a given system.

10. Levee System Summary (Segment): Same as above report by query able by segment and reports only shown
for uploaded documents.

ok~

©ooNe

By clicking on a report link, in this case Segment Detail report, you will be taken to the report view shown
below in Figure 4-11: View Report.

12
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US Army Corps of Engineers

Home EGEINUIE Maps Help AboutNLD ContactUs

National Levee Database

sFeedback ] Login

Segment Detail Report
I
r Lpetons |
1-500f 3247 )
FEMA  Cong FCSystem  FC Design Design  Engineer Segment Length  Risk o
Division |- Organzalion.| . o | Disict | 2 1o)== Countyfes) D |Seqmeniip| SysemName.Segment Name. . Sponsorfs) Flow Frequency NFPDate NFIP (Mies)  Assignment uihorzation Type PI'_?v:f"
SOUTH  JACKSONVILLE Region | Florida-23 Florida | Broward County, 3405000037 3404000024 Westem EAA L1 East South Florida Water - 550 - - - 8T7 No iUSACE Federally Yes
ATLANTIC 2] Hendry County, Palm Management District constructed, tuned over to
Beach County ‘ | public sponsor operations
|and maintenance
SOUTH  JACKSONVILLE Region |Florida-23 Florida | Palm Beach County | 3405000038 3404000025 L-8 West, L-10and  |L-10 South Florida Water 4600 450 - - 4101726 No |USACE Federally Yes
ATLANTIC 2] - Management District |constructed, turned over to
‘ | public sponsor operations
[ 1 s WP B [P [ = SO = - S | 1 L __|and maintenance 1=
SOUTH  JACKSONVILLE Region |Florida- 16, Florida  Martin County, 3405000067 3404000134 NE Lake Okeechobee |L65 East South Florida Water - -- - - 6.91% No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County ‘ public sponsor operations
|and maintenance
SOUTH  JACKSONVILLE Region |Florida- 16, Florida  Martin County, 3405000067 3404000135 NE Lake Okeechobee |L64 East South Florida Water - .- - - 4382 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County ‘ public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida  Mattin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water - -- - - 49459 No  |USACE Federally Yes
ATLANTIC 0 Florida - 23 Okeechobee County, Watershed Management District |constructed, tuned over to
Saint Lucie County ‘ | public sponsor operations
\and maintenance
SOUTH  JACKSONVILLE Region |Puerto Rico |Puetto | Ponce Municipio 3405000026 3404000139 Bucana East |Bucana Upper  Dept. of Environment and - - - - 34254 No |USACE Federally Yes
ATLANTIC 02 -98 Rico |East Natural Resources, constructed, tumed over to
| Commonwealth of Puerto | public sponsor operations
Rico and mail

Figure 4-11: View Report

4.5 Interactive Reporting Tools

NLD reports are fully customizable. All columns are customizable so that you may search, organize, and filter
the data using the interactive reporting tool features. These tools can be accessed by selecting the column
headings and also from the “Actions” button, which provides additional search and display features.

The basic functions of the interactive reporting tool include the following:

S Army Corps of Engineers

Home EEG(M Maps Help AboutNLD Contact Us

National Levee Database

 Feedback ] Loginf

~
/v Actions 3
2 1-500f 3247 )
FEMA = Cong FCSystem  FC Design  Design = Engineer  Segment Length Risk oS
Division  Organization Region  Disrit State(s)  County(ies) D Seqnentd System Name  Segment Name Sponsor(s) Fow Frequency NFPDate  NFP Freeboard (Mies) Assignment Authorization Type Plr_?l;a;n
SOUTH  JACKSONVILLE Region | Florida-23 Florida | Broward County, 3405000037 3404000024 Westem EAA |L-1 East South Florida Water - 550 - = - 877 No iUSACE Federally Yes
ATLANTIC 04 Hendry County, Palm Management District |constructed, turned over to
Beach County ‘ public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region  Florida-23 Florida  Palm Beach County | 3405000038 3404000025 L-8 West, L-10and  |L-10 South Florida Water 4600 450 - - 4 101726, No |USACE Federally Yes
ATLANTIC 04 L-12 Management District |constructed, tuned over to
‘ | public sponsor operations
T = [ — o P e ‘ . | | — ___|and maintenance i
SOUTH  JACKSONVILLE Region | Florida- 16, Florida  Martin County, 3405000067 3404000134 NE Lake Okeechobee |L65 East South Florida Water - -- = - 6919 No |USACE Federally Yes
ATLANTIC i) Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County ‘ | public sponsor operations
|and maintenance
SOUTH  JACKSONVILLE Region | Florida- 16, Florida  Martin County, 3405000067 3404000135 NE Lake Okeechobee |L64 East South Florida Water - -- - - 4382 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County ‘ public sponsor operations
|and maintenance
SOUTH  JACKSONVILLE Region |Florida- 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water E - - - 49459 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed | Management District |constructed, tumed over to
Saint Lucie County ‘ | public spansor operations
and maintenance
SOUTH  JACKSONVILLE Region |Puerto Rico |Puerto |Ponce Municipio 3405000026 3404000139 Bucana East |Bucana Upper  Dept. of Environment and - -- - - 34254 No  |USACE Federally Yes
ATLANTIC -9 Rico |East Natural Resources, constructed, tumed over to
| Commonwealth of Puerto | public sponsor operations
Rico (and

Figure 4-12: View Report
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1.

2.

3.

45.1

Search (Magnifying Glass): Allows you to search and filter by a keyword within a specific column. For
a complete list of columns, see Figure 4-13: Search

Go: Allows you to submit request to search the NLD and display search results based upon the search
criteria entered

Actions button: Allows you to customize the report to your liking. Options include Select Columns,
Filter, Rows Per Page, Sort, Control Break, Highlight, Compute, Group By, Reset, Help and Download

Search

The “Search” feature allows you to search and filter the report for a specific keyword or value within the report.

National Levee Database
nglneerS o Feedvack | Login
elp hou
Sgqment Detail Report /
/v State(s) California Go Actions
All Columns
Division 1-500f 3247 )
Organization Corps
Cong. FCSystem  FC Design  Design  Engineer Segment Length  Risk
FEMA Region
g District State 4 ty(ies) D Segmentid System Name | Segment Name Sponsor(s) Flow | Frequency NFPDate NFP Freeboard (M) | Assignment Authorization Type  Program
Cong. District Levee
{State(s) lorida - 23 Floridal unty, 3405000037 | 3404000024 Westem EAA L-1 East South Florida Water g 550/- - - 877 No USACE Federally Yes
| Countyfies) Hendry County, Palm Management District constructed, tumed over to
Beach County public sponsor operations
FC System D and maintenance
{FC Segment ID ja-23 Florida  Palm Beach County | 3405000038 | 3404000025 L-8 West, L-10and  |L-10 South Florida Water 4600 450 - 4 101726 No USACE Federally Yes
+ System Name Management District constructed, tumed over to
Segment Name public sponsor operations
and maintenance
 Sponsor(s) orida - 16, Florida  Martin County, 3405000067 | 3404000134 NE Lake Okeechobee  |L65 East South Florida Water - 69194 No |USACE Federally Yes
4 Design Flow orida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Design Frequency Saint Lucie County public sponsor operations
g NFIP Dat and maintenance
{Egneet G |orida - 16, Florida  Martin County, 3405000067 3404000135 NE Lake Okeechobee |L64 East South Florida Water - 4382 No  |USACE Federally Yes
| Segment NFIP lorida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Freeboard Saint Lucie County public sponsor operations
Length (Miles) and maintenance
H lorida - 16, Florida  Martin County, 3405000067 | 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water - 49459 No USACE Federally Yes
|Risk Assignment orida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Authorization Type Saint Lucie County public sponsor operations
Corps Program Levee and maintenance
SUUTHTIRCKSUNVIEEETREgIM™TFUerto Rico  Puerto  Ponce Municipio 3405000026 3404000139 Bucana East Bucana Upper  Dept. of Emvironment and - 34254 No USACE Federally Yes
ATLANTIC -9 Rico East Natural Resources, constructed, tumed over to
Commonwealth of Puerto public sponsor operations
Rico and maintenance

arOE

Figure 4-13: Search

Figure 4-14: Loading Symbol

14

Click on the “magnifying glass” icon, a list of columns will display
Select a column name to search and filter the report by

Insert search criteria (keyword or value) in the search box
Click the “Go” button to submit the search
Figure 4-14: Loading Symbol
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eers s Feedback | Login
Seg | Report 8
e \l‘/Go [ Actions 7
- s
g 7 state(s) contans ‘Cattomia ¥ § <—— 9 \l/
1-500f570 )
FENA FCSystem FC Desgn Design  Engineer  Segment Length  Risk SR

Division  Organization REF Cong. District  State(s) ~ County(ies) D Seqnentid SystemName ~ Segment Name  Sponsor(s) Fow Frequency NFPDAe  NFP Freeboard Lol Authorization Type P[r;\er;m
SOUTH  SAN Region  Califonia - 15, |Califomia| Santa Clara 5305000015/ 5304000016 Guadalupe River - Guadalupe River - RB Santa Clara 18325 100/- - 3 69024  No  |USACE Federally constructed, | Yes
PACIFIC |FRANCISCO |09 California - 16 County RB Valley WD tumed over to public sponsor

operations and maintenance
SOUTH | SAN Region  California - 01 |California| Del Norte County | 5305000019 5304000020 Lower Klamath - RB |Lower Klamath - RB  Del Norte County = 700000 -- - - 16818 No USACE Federally constructed, | Yes
PACIFIC |FRANCISCO |09 turned over to public sponsor

operations and maintenance
SOUTH | SAN Region | California - 14, | California| Santa Cruz 5305000024| 5304000025 Pajaro River Pajaro River Santa Cruz 22000 50- - - 85138 No USACE Federally constructed, | Yes
PACIFIC  FRANCISCO 09 California - 17 County Downstream-RB | Downstream-RB  County PWD tuned over to public sponsor

operations and maintenance
SOUTH  SAN Region  California - 14, | California| Santa Cruz 5305000025/ 5304000026 Pajaro River Pajaro River Santa Cruz 22000 50 - - - 6.8507 No USACE Federally constructed, | Yes
PACIFIC |FRANCISCO |09 California - 17 County Upstream - RB Upstream - RB County PWD tumed over to public sponsor

operations and maintenance
SOUTH | SAN Region | California - 17 |California| Monterey County | 5305000026| 5304000027 Pajaro River - LB | Pajaro River-LB  Monterey County = 22000 50- - <923 No USACE Federally constructed, | Yes
PACIFIC |FRANCISCO |09 WD turned over to public sponsor

operations and maintenance
SOUTH | SAN Region | California - 07 | California| Contra Costa 5305000027, 5304000028 Pinole Creek LB Pinole Creek-LB  Contra Costa B -- - - M3 No USACE Federally constructed, | Yes
PACIFIC |FRANCISCO |09 County County PWD tumed over to public sponsor

operations and

Figure 4-15: Display Criteria

After the system loads, it will display the customized filter and search criteria below the search bar
The interactive reporting capability displays a table of results based upon your search criteria

By clicking the checked box on and off you can remove the specific search terms from the results table
By clicking the “Filter” icon with the red “X” you can completely remove the specific search terms

© oo Ne

45.2 Actions Menu

The Actions Menu contains many tasks that are useful in manipulating an Interactive Report. All Interactive
Reporting functions from the Actions Menu are displayed in the example report as shown in Figure 4-16:
Actions Menu Functions.

4521 Select Columns

The “Select Columns” option in the actions menu allows you to reorder/modify the columns displayed in a
report.

15
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US Army Corps of Engineers E—

Home QGIVicl Maps Help AboutNLD ContactUs

Segment Detail Report 1
N
r &
" Select Columns % 2 1-500f3247 )
i § 3 Corps
L FEMA ~ Cong. . Design  Design  Engineer Segment Length = Risk e
DA OGN0 P i S ] 7 e Eqrentip| ~ Systembame, | SeqmentName | SpOnsars)- | o™ reniency I NEP Dale| NEP || e 02 s | Aesignnent |~ Authorzation Type P{g:f“
SOUTH  JACKSONVILLE Region Florida-23 Florida | ~{Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water - 550 - - - 8737 No  |USACE Federally Yes
ATLANTIC 04 Management District constructed, tumed over to
S Format ) public sponsor operations
{ | and maintenance
SOUTH  JACKSONVILLE Region  Florida-23 Florida 404000025 L-8 West, L-10and  |L-10 South Florida Water 4600 440 - - 4 104726 No  |USACE Federally Yes
ATLANTIC 04 0 Reset L-12 Management District constructed, tumed over to
public sponsor operations
and maintenance
SOUTH  JACKSONVILLE Region  Florida- 16, Florida J Help 404000134 NE Lake Okeechobee  L65 East South Florida Water s 88 2 - 691%  No  USACE Federally Yes
ATLANTIC 04 Florida - 23 Watershed Management District constructed, tumed over to
=== public sponsor operations
= Donload and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida “wiararouurcy;——ro~wovwuver 404000135 NE Lake Okeechobee |L64 East South Florida Water - - - < 4382 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations
and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water - -- - - 49459 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations
and maintenance

Figure 4-16: Actions Menu Functions

1. Click on the “Actions” button
2. Click on “Select Columns,” a new region will display as shown below in Figure 4-17: Actions Menu -
Select Columns

B Tl

National Levee Database

Us Ar‘rﬁ; Corps of Engineers JFestback g Logn

Home WG Maps Help AboutNLD Contact Us
=

A @) )

Segment Detail Report

~ Select Columns
Do Not Display Display in Report

Construction Start Date + | |Division -

Construction Completion Datef Qrganization B
3 || | el gty nspecion e 4 8 FEMA Region E

FIRM Exclusion \») Cong. District g

._ilood Reduction Channel 9 [State(s)

PAL Status ¢ Couniy(ies) 6 &

RIP Status 5 >« FC System ID 9

Segment Min Elevation FC Segment ID

Segment Max Elevation ~ | |System Name \I/ = 7

1-500f3247 )

. . 2 . Corps
. X FEMA  Cong. FCSystem  FC Design Design | Engineer Segment Length Risk et
Division ~ Organization Regon| Distict State(s)  County(ies) D Seqnentid SystemName  Segment Name Sponsor(s) Fou Frequency NFPDate NFP Freeboard (Mies) | Assignment Authorization Type Plr_t;g‘z/r;m
SOUTH | JACKSONVILLE Region |Florida-23 |Florida  Broward County, 3405000037 3404000024 Western EAA |L1 East South Florida Water - 550 - - BRI No USACE Federally Yes
ATLANTIC 04 Hendry County, Palm Management District constructed, tumed over to
Beach County public sponsor operations

and

Figure 4-17: Actions Menu - Select Columns

3. Click on a column name (i.e. “PAL Status”) in the “Do Not Display” table. The column name will
become highlighted (Note: You can also click on a name in the “Display in Report” Column)

4. Click the single arrow to move it over to the “Display in Report” table. The arrow pointing right will
move the column to the “Display in Report™ table and vice versa

5. To move all columns to one side or the other, click the double arrows

16
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6. Click the “Cancel” button to reset
7. Click the “Apply” button to have your desired column settings displayed

4522

Filtering Option

The “Filter” option allows you to modify the report query through the use of Oracle operators and/or
expressions.

/v

Division

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

Segment Detail Report

Organization FERL

JACKSONVILLE Region
04

JACKSONVILLE Region
04

JACKSONVILLE Region
04

JACKSONVILLE Region
04

JACKSONVILLE Region
04

[E | Actions

cong.

Region  District

Florida - 23

Florida - 23

Florida - 16,

Florida - 23

Florida - 16,
Florida - 23

Florida - 16,

Florida - 23

State(s

Florida

Florida

Florida

Florida

Florida

~ Select Columns

7 Filter % 2 lcnt D System Name  Segment Name: Sponsor(s)
- Rows Per Page 000024 Westem EAA L1 East South Florida Water

== Format
3 404000025 L-8 West, L-10 and
’ Reset L2
J Help 404000134 NE Lake Okeechobee
Watershed
Wf; Download
GGGy, GTUIUITIuT 2404000135 NE Lake Okeechobee
Okeechobee County, Watershed
Saint Lucie County
Martin County, 3405000067 | 3404000136 NE Lake Okeechobee
Okeechobee County, Watershed
Saint Lucie County

L0

L65 East

L64 East

Management District

South Florida Water
Management District

South Florida Water
Management District

South Florida Water
Management District

163 South East  South Florida Water

Management District

Design  Design  Engineer Segment
Flow | Frequency NFIPDate  NFIP

4600

Freepoard LTV

550 - - - 877
450 - - 4 101726
- 6919
- 4382
- 49459

National Levee Database

Risk
(Mies) Assignment

No

No

No

No

No

1-500f 3247 )

Authorization Type

USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance

USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance

USACE Federally
constructed, tumned over to
public sponsor operations
and maintenance

USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance

USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance

5 Feedback ﬁj Login

Corps
Program
Levee
Yes

Yes

Yes

N =

Figure 4-18: Actions Menu Functions

Click on the “Actions” button
Click on “Filter.” A new filter region will display as shown below in Figure 4-19: Actions Menu - Filter

3. Click on “Rows Per Page” to select the number of rows you’d like to display on each report page. (All
reports will default to a view of 50 rows per page)

17

30-JUN-2015



NLD User Manual

United States Army Corps of Engineers

Segment Detail Report

=

( Filter
4 5

Filter Type (@ Column (@) Roy

National Levee Database

Column \l/ Operator Expression
State(s) v = v California
7
S FEMA  Cong - FCSystem  FC Design  Design | Engineer Segment Length  Risk
ivision nization i n tem nt N NSO Fi rd
B g Region  District SRS O 5 D SegmentID el SpOLSHfS) Flow | Frequency NFIPDate NFIP (eeioa (Miles)  Assignment
SOUTH | JACKSONVILLE Region Florida-23 |Florida  Broward County, 3405000037 3404000024 Western EAA L-1 East South Florida Water - 550 - - 877 No
ATLANTIC 04 Hendry County, Palm Management District
Beach County
SOUTH | JACKSONVILLE Region Florida-23 Florida  Palm Beach County | 3405000038 3404000025 L-8 West, L-10and ~ |L-10 South Florida Water 4600 450 - 410.1726 No
ATLANTIC 04 - Management District

o Feedback | Logn

1-500f 3247 )

Corps.
Authorization Type  Program
Levee
USACE Federally Yes
constructed, tumed over to
public sponsor operations
and maintenance
USACE Federally Yes

constructed, tumed over to
public sponsor operations
and maintenance

Figure 4-19: Actions Menu - Filter

Select a column by clicking on the “Column’ dropdown list
Select an operator by clicking on the “Operator” dropdown list

SRS o

field

Select an expression by clicking on the “Expression” dropdown list or type your own expression into the

7. Click the “Apply” button. Results are filtered. You can apply multiple filters to the report view, enable or
disable them by checking them on or off, and remove them if necessary (see steps 8-9 under Figure 4-15:

Display Criteria)
4523 Sort

The “Sort” option in the actions menu allows you to arrange the columns in a report.

18

30-JUN-2015



NLD User Manual United States Army Corps of Engineers

— , National Levee Database

{
US Army Corps of Engineers itk i

Home QGGVGIGH Maps Help AboutNLD Contact Us

Segment Detail Report

11
/ﬁ, Actions

= Select Columns 1-500f 3247 )
FEMA  Cong. FC Design  Design  Engineer  Segment Length  Risk Cope
Division  Organization . State(s 8) N Nal nsor(s) Freeboard Authorization Ty Pr
NSO o= ORGANCRNON e cgion | ™ Distict e V il 2qment ID VSHGI Nt SO AT S0V Flow  Frequency NFIPDate  NFIP (Mies) Assignment M s [Z?/Zm
SOUTH |JACKSONVILLE Region Florida-23 Florida | ~{Rows Per Page ¥ 1404000024 Westem EAA L1 East South Florida Water - 550/ o 4 877 No USACE Federally Yes
ATLANTIC 04 = | District |constructed, tumed over to
I Format Mo | public sponsor operations
| { §$ Sot e 2 and maintenance
SOUTH | JACKSONVILLE Region |Florida-23 |Florida South Florida Water 4600 450 - - 4101726 No  |USACE Federally Yes
ATLANTIC 04 Control Break District constructed, tumed over to

\‘ Reset

| public sponsor operations
\and maintenance

SOUTH  JACKSONVILLE Regin Fiida- 16, Fiida | () Help Highight St South Floida Water ; I z - 691%  No |USACE Federally Ves
ATLANTIC 04 Florida - 23 Management District constructed, tumed over to
=== Compute | public sponsor operations
- Download |and maintenance |
SOUTH | JACKSONVILLE Region  Florida - 16, |Florida “wiarrwwarny; wmwavosery Group By Zast South Florida Water - -- - <4382 No |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, L Management District |constructed, tumed over to
Saint Lucie County public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region Florida - 16, |Florida | Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water - -- - - 49459 No |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations
\and maintenance

Figure 4-20: Advanced Search Options

1. Click on the “Actions” button
2. Click on “Format” > “Sort.” A new sort region will display as shown below in Figure 4-21: Actions
Menu - Sort

gy National Levee Database
us Army Corps of Engineers o Feethack ] Logn

Home REMNICHM Maps Help AboutNLD Contact Us

r'
/ 3 4

14
i Sort
Column N Direction Null Sorting

Segment Detail Report

1 - Select Column - v Ascending v Default v
2 - Select Column - v Ascending v Default v
3 - Select Column - v Ascending v Default v
4 - Select Column - v Ascending v Default h
5 - Select Column - v Ascendlng v Default g
6 - Select Column - v Ascending v Default M

o] [k G

1-500f 3247 )

5 5 : Corps.
RS e FEMA  Cong. . FC System FC Design  Design  Engineer Segment Length Risk A
Division  Organization Region  Distrct State(s)  County(ies) D Segnentd System Name ~ Segment Name Sponsor(s) Fow Frequency NFPDale  NFP Freeboard o Authorization Type P[Z?/r:em
SOUTH | JACKSONVILLE Region Florida-23 Florida  Broward County, 3405000037 3404000024 Westem EAA L1 East South Florida Water - 550 - - - 8737 No USACE Federally Yes
ATLANTIC 04 Hendry County, Palm Management District constructed, tuned over to
Beach County public sponsor operations
B B B and maintenance |

SOUTH |JACKSONVILLE Region  Florida-23 Florida  Palm Beach County | 3405000038 3404000025 L-8 West, L-10and ~ |L-10 South Florida Water 4600 450 - - 4/ 101726 No  |USACE Federally Yes
ATLANTIC 04 L-12 Management District constructed, tumed over to

public sponsor operations

land

Figure 4-21: Actions Menu - Sort

3. Click on dropdown arrow in the Columns box to change columns to sort

4. Click the dropdown arrow in the Direction box to sort the reports in ascending or descending order

5. Click the dropdown arrow in the Null Sorting box to determine where you want your null results to
populate

6. Click the “Apply” button (you also have the choice of clicking the “Cancel” button)
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4524 Control Break

The “Control Break” option in the actions menu allows you to organize the data by grouping results into
sections.

T
WL | »
. National Levee Database
US Army Corps of Engineers e
Home EGEIICE Maps Help AboutNLD Contal
§ 5
Segment Detail Report il
6 =
A =] —
= Select Columns 1-500f3247 )
FEMA  Cong FC Design Design  Engineer Segment Length  Risk S
Divisi Qrganizati o 8t i S) it N Fi Authorizati Pi
e Sl Region  District Blcly ? Fier egment ID YHET NG s ST SACS) Flow  Frequency NFIPDate NFIP e (Miles)  Assignment HRElDE I'_‘;%:m
SOUTH  JACKSONVILLE Region Florida-23 Florida | [~{Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water | 550 - 2 - 8737 No :USACEFederaHy Yes
ATLANTIC 4 | Management District |constructed, tumed over to
e Format ) | public sponsor operations
| B Sott |and maintenance
SOUTH | JACKSONVILLE Region |Florida-23 Florida South Florida Water 4600 450 - - 4104726 No  |USACE Federally Yes
ATLANTIC 04 \‘ Reset Control Break e 2 Management District |constructed, tumed over to
public sponsor operations
B e e e e | B it e I | | L lndmaimenance
SOUTH  JACKSONVILLE Region  Florida - 16, Florida 0 Help [ Mg ast South Florida Water - - - - 69194 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Management District |constructed, tumed over to
=== Compute | public sponsor operations
B gannIaad ‘ |and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, |Florida “wiararrosary;——wwoowvovrr{ (=4 Group By Zast South Florida Water - -- - - 43R No  |USACE Federally Yes
ATLANTIC (3 Florida - 23 Okeechobee County, Lo | Management District |constructed, tumed over to
Saint Lucie County public sponsor operations
) |and maintenance
SOUTH | JACKSONVILLE Region  Florida- 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water - - - - 49459 No |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District |constructed, tumed over to
Saint Lucie County public sponsor operations
|and maintenance

Figure 4-22: Actions Menu Functions

1. Click on the “Actions” button
2. Click on “Format” > “Control Break.” A new region will display as shown below in Figure 4-23:
Actions Menu - Control Break

,,,,,, National Levee Database

I US Army Corps of Engineers Pe——
@

LI Reports

Segment Detail Report
n —
/v

ontrol Break
Column I Status

1 - Select Column - v Enabled v
2 - Select Column - v Enabled v 4
3 - Select Column - v Enabled v
4 - Select Column - v Enabled v
5 - Select Column - v Enabled v
6 -SelectColumn- v Enabled v
o <— 5

1-500f2943 )

) : : Corps
.. FEMA o . FCSystem  FC Design  Design  Engineer Segment Length  Risk s
Division  Organization o Cong. District State(s)  County(ies) D Segmentld System Name Segment Name  Sponsor(s) Flow | Frequency NFPDale  NFP Freeboard ) S Authorization Type P'l_:gv::n
NORTH  NEW Region  Connecticut-04  Connecticut  Fairfield 4305000051/ 4304000057 Stamford HSPP, CT Stamford HSPP, CT- |- E |- - | No  |USACE Federally Yes
ATLANTIC |ENGLAND 01 County ‘ CENAE | Constructed and USACE
| | |Federally Operated

NORTH  \NEW Region  Connecticut- 04 Connecticut  Faifield 4305000051/ 4304000058 Stamford HSPP, CT Stamford HSPP, CT- |- - .- - - 17455 No |USACE Federally Yes
ATLANTIC |ENGLAND 01 County Stamford |constructed, tumed over to

public sponsor operations

| |and

Figure 4-23: Actions Menu - Control Break
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3. Click on dropdown arrow in the Columns box to group data into several columns
4. Click the dropdown arrow in the Status box to enable or disable the column
5. Click the “Apply” button (You also have the choice of clicking the “Cancel” button)

4525 Highlight

The “Highlight” option in the actions menu allows you define a filter and view the filtered results using custom
color options.

it

L TR

: National Levee Database
US Army Corps of Engineers etk gl

Home WGVl Maps Help AboutNLD Contact Us

Segment Detail Report 1
n
A
=1 Select Columns 1-500f 3247 )
FEMA  Cong. FC Design  Design  Engineer Segment Length  Risk Cup
o E : G . 5 :
Division ~ Organization Regon | Distit State(s ? Filter sqrentid System Name  Segment Name Sponsor(s) Fou Frequenty NFPDde NP Freeboard (Mies) Assignment Authorization Type PLt:]lZm
SOUTH | JACKSONVILLE Region Florida-23 |Florida | [**Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water - 550 - - < 8737 MNo  |USACE Federally Yes
ATLANTIC 04 al | Management District |constructed, tumed over to
I Format ) | public sponsor operations
| } and maintenance
SOUTH | JACKSONVILLE|Region Florida-23 |Florida South Florida Water 4600 450 - - 4104726 No |USACE Federally Yes
ATLANTIC 04 \‘ Reset District Iconstructed, tumed over to
2 | public sponsor operations
-~ —— TS % e B p = \and maintenance )
SOUTH  JACKSONVILLE Region Florida - 16, Floida bt South Florida Water ; e o D691%  No|USACE Federally Ves
ATLANTIC 04 Florida - 23 District constructed, tumed over to
Compute | public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region Florida - 16, Florida “rwusarouany;- SHUIIIYUTT| l{—— Group By Cast South Florida Water g | = - 4382 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, [ Management District constructed, tumed over to
Saint Lucie County public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region Florida- 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water - - - - 49459 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District |constructed, tumed over to
Saint Lucie County public sponsor operations
|and maintenance

Figure 4-24: Actions Menu Functions

1. Click on the “Actions” button
2. Click on “Format” > “Highlight.” A new highlight region will display as shown below in

i

National Levee Database

USAr;; Corps of Engineers {Fesdback ] Logi

Home BEGJVicM Maps Help AboutNLD Contact

Segment Detail Report

~

A
~IHighlight
Name
Sequence 10
Enabled Yes v
Highlight Type Row v
Background Color B [yellow] [green] [blue] [orange] [red]
Text Color | |:| [yellow] [green] [blue] [orange] [red]
Highlight Condition
Column Operator Expression
Division v|= v
Apply

1-500f3247 )

Corps
s — FEMA  Cong. FC System FC Design  Design  Engineer = Segment Length Risk
Division ~ Organization Region  Distit State(s)  County(ies) D Segmentid SystemName  Segment Name Sponsor(s) Fow  Frequency NFIPDae  NFP Freeboard Mies) | Assignment Authorization Type Pgn;m

SOUTH  JACKSONVILLE Region |Florida-23 Florida | Broward County, 3405000037 | 3404000024 Western EAA L-1 East South Florida Water E 550/~ - - 87317 No USACE Federally Yes
ATLANTIC 04 Hendry County, Palm Management District constructed, turned over to

Beach County public sponsor operations

. . . . and maintenance

SOUTH  JACKSONVILLE Region |Florida-23 Florida | Palm Beach County 3405000038 3404000025 L-8 West, L-10 and L-10 South Florida Water 4600 450 - & 4101726 No USACE Federally Yes
ATLANTIC 04 Management District constructed, tumed over to

public sponsor operations
and maintenance
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3. Figure 4-25: Actions Menu - Highlight

National Levee Database

u’/lu( -
US Army Corps of Engineers Foacbock i Loge

8 Reports
Segment Detail Report
/v Go Actions
Highlight
Name é‘ 3
4 % Sequence 10

Enabled Yes v 6 5

Highlight Type Row v
6 Background Color D |_| [yellow] [green] [blue] [orange] [red] 7
Text Color D |:| [yellow] [green] [blue] [orange] [red]

Highlight Condition
Column Operator Expression

—> Division v = v M

l=]

1-500f3247 )

Corps
e . FEMA | Cong FCSystem  FC Design Design  Engineer Segment Length  Risk
Division  Organization Region | Distrct State(s) County(ies) D Segment D System Name Segment Name Sponsor(s) Flow Frequency NFIPDate NFP Freeboard (Mies) | Assignment Authorization Type P[Z?:em

SOUTH  JACKSONVILLE Region | Florida-23 Florida | Broward County, 3405000037 | 3404000024 Western EAA L1 East South Florida Water E 550/~ = - 8737 No USACE Federally Yes
ATLANTIC 04 Hendry County, Palm Management District constructed, tumed over to

Beach County public sponsor operations

and maintenance

SOUTH  JACKSONVILLE Region |Florida-23 Florida | Palm Beach County 3405000038 3404000025 L-8 West, L-10 and L-10 South Florida Water 4600 450 - - 4101726 No USACE Federally Yes
ATLANTIC 04 Management District constructed, tumed over to

public sponsor operations
and maintenance

Figure 4-25: Actions Menu - Highlight

4. Enter a “Name” for a customized highlight filter

Enter a number in the “Sequence” box. A sequence identifies the sequence in which the rules will be

evaluated

Select an “Enabled” status (Yes or No). This identifies if the rule is enabled or disabled

Select the “Highlight Type.” This will identify whether the Row or Cell should be highlighted

8. You can apply colors to certain data set by clicking on the color links beside the background color box
and text color box. If you do not like the color selections given by the links, click on the multicolor box.
A separate window will display with more color options

9. By selecting the Column, Operator, and Expression in the Highlighted Condition section you will define
your filter condition

10. Click the “Apply” button. The fields you selected will be highlighted. (You also have the choice of
clicking the “Cancel” button)

o

~No

45.2.6 Compute

The “Compute” option in the actions menu allows you to add computed columns to a report. These can be
mathematical computations or standard Oracle functions applied to existing columns.
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Division

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

SOUTH
ATLANTIC

Segment Detail Report

/v

FEMA

Organization Region

JACKSONVILLE Region | Florida - 23
0

JACKSONVILLE Region
[

JACKSONVILLE Region
04

JACKSONVILLE Region
04

JACKSONVILLE Region
04

/
Actions’

~ Select Columns
Cong. FC Design  Design  Engineer Segment
Disret | 2l V bikel sqentip| SYStemName - Segnentare, - SpOISQNS) " e ency | NFPDale| NFIP
Florida | == Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water 550 -
Management District
“+ Format 4 %{ Sot
Florida - 23  Florida South Florida Water 4600 480 -
( »@ Reset = Control Break Management District
Florida - 16, | Florida o it Eact__¥a | South Florida Water
Florida - 23 Management District
E Compute % 2
Florida - 16, Florida “wwararr-ooury; - == Group By Zast South Florida Watgr
Florida - 23 Okeechobee County, L Management District
Saint Lucie County
Florida - 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water
Florida - 23 Okeechobee County, Watershed Management District

Saint Lucie County

-

Length
(Miles) - Assignment

87317

10.1726

6.9194

4382

- 49459

National Levee Database

o Feedback | Login

1-500f3247 )

Corps
Program
Levee

No  |USACE Federally Yes
constructed, tumed over to
public sponsor operations
and maintenance

No  |USACE Federally Yes
constructed, tumed over to

REE T thorzaton Type

No

No

No

public sponsor operations
and maintenance
USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance
USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance
USACE Federally
constructed, tumed over to
public sponsor operations
and maintenance

Figure 4-26: Actions Menu Functions

1. Click on the “Actions” button

2. Click on “Format” > “Compute.” A new computation region will display as shown below in Figure

4-27: Actions Menu - Compute

Segment Detail Report

"
A
.

1| Compute

Computation - New Computation - ~

3

Column Heading Format Mask % 5
Computation Expression 4 N
6
Columns Keypad Function

C FEMA Region i () I ABS I;\

D. Cong. District ‘i‘ T| 8|9 - ADD_MONTHS B

E. County(ies) 4 5| 6| + CASE

F  Division 1,2 3| * CEIL

G Organization 0 / CHR

H. System Name space COALESCE

Create a computation using column aliases.

Examples:
1. (B+C)™100
2 INITCAR(B)I", "IINITCAR(C)

3. CASE WHEN A = 10 THEN B + C ELSE B END

Apply

Figure 4-27: Actions Menu - Compute

3. Click on the dropdown arrow in the “Computation” box to select a computation
4. Fill in the “Column Heading” box
5. Select a “Format Mask” to define how the data is to be displayed
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6.

4527

Fill in “Computation Expression” box. Within the computation columns are referenced using the aliases
displayed. Clicking on the column name or alias will write them into the Computation Expression box.
Please note the keypad is displayed as a shortcut. These are commonly used keys

Click the “Apply” button (You also have the choice of clicking the “Cancel” button)

Group By

The “Group By” option in the actions menu allows you to select multiple filters to group your report results by.
The “Group By” function allows the user to select functions and sort a group of one to three report column
headings.

Segment Detail Report 1

- L
A Actions

-~ Select Calumns 1-500f3247 )
FEMA  Cong. FC Design  Design  Engineer Segment Length  Risk s
F
Division ~ Organization Regon  Distt State(s ? Filter sqrent D System Name ' Segment Name Sponsor(s) Fou Frequeney \FPDate NP reeboard (Mies) | Assignment Authorization Type P[«;%Zm
SOUTH | JACKSONVILLE Region  Florida-23 Florida Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water L 550 - - - 877 No  |USACE Federally Yes
ATLANTIC [ Management District constructed, tumed over to
Fommiat Mo public sponsor operations
%5 Sort and maintenance
SOUTH | JACKSONVILLE Region Florida-23 Florida South Florida Water 4600 450 - - 4 101726 No  |USACE Federally Yes
ATLANTIC 04 9 Reset Control Break Management District constructed, tumed over to
public sponsor operations
Hiahliah and maintenance
SOUTH  JACKSONVILLE Region  Florida - 16, Florida J Help ighight Zast South Florida Water - - - - 6.91%4 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 - Management District constructed, tumed over to
= i Compute public sponsor operations
4 Doinload - 5 and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida “warovariy;——<=vovsovur 1 g 6 < South Florida Water - - - <438 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, T Pl 2 Management District constructed, tumed over to
Saint Lucie County 0 public sponsor operations
and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water - - - - 49459 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations

National Levee Database

o Feedback i Login

and maintenance

1.
2.

Figure 4-28: Actions Menu Functions

Click on the “Actions” button
Click on “Format” > “Group By.” A new group by region will display as shown below in Figure 4-29:
Actions Menu - Group By
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r:éorps of Engineers

4528

(LSl Maps Help AboutNLD Contact Us
Segment Detail Report
~ )
v Go Actions
3 Group By 3
Group By Column
1 - Select Column - v 2 -Select Column - v 3 - Select Column - -
Functions Column Label 5 Format Mask Sum
1 - Select Function - = - Select Column - - =
2 - Select Function - ¥ - Select Column - - =
3 - Select Function - ~ - Select Column - - =
Sort Column Direction Null Sorting
> 1 - Select Sort Column - ~ Ascending ~ Default -
2 -Select Sort Column- v Ascending ~ Default -
3 - Select Sort Column- v Ascending ~ Default -
[ Appy & 7

4.

o1

Figure 4-29: Actions Menu - Group By

Click on the dropdown arrows in the “Group By Column” boxes to select the columns to group by
Click on the dropdown arrows to select functions to perform on the associated selected columns
Create a Label and Format Mask for the column functions selected

Sort the report by selected columns

Click the “Apply” button (You also have the choice of clicking the “Cancel” button)

Reset

The “Reset” option in the actions menu allows you to reset the report back to the default settings and remove
any customizations that were added.

~~—— National Levee Database
2 »v i
S Army Corps of Engineers Fedeck g
Home ELGVicl Maps Help AboutNLD Contact Us
Segment Detail Report 1
N
A
= Select Columns 15003247 )
FEMA  Cong FC Design Design  Engineer Segment Lengh | Risk Cors
Division ~ Organization Regon!" Dl State(s ‘7 Filter SqnentiD SystemName  Segment Name Sponsor(s) Flow | Frequency NFPDate NFP Freeboard (Mies)  Assignment Authorization Type P[t:‘;l:m
SOUTH  JACKSONVILLE Region | Florida-23 Florida | *{Rows Per Page P 404000024 Wester EAA L1 East South Florida Water 550 - - 87T No  |USACE Federally Yes
ATLANTIC 04 Management District constructed, tumed over to
= Format ) public sponsor operations
| B | |and maintenance
SOUTH  |JACKSONVILLE Region  Florida- 23 Florida inbg0gs L5 West, L10and |0 South Florida Water 4600 450 - 4101726 No  |USACE Federally Yes
ATLANTIC 04 Reset e L12 Management District constructed, tumed over to
\‘ 2 public sponsor operations
| - |and maintenance
SOUTH  JACKSONVILLE Region  Florida- 16, Florida d Help 404000134 NE Lake Okeechobee  L65 East South Florida Water - 691%  No  USACE Federally Yes
ATLANTIC 04 Florida - 23 Watershed Management District constructed, tumed over to
= public sponsor operations
g Download and maintenance
SOUTH | JACKSONVILLE Region |Florida- 16, Florida “waramouary; reaTavOT 404000135 NE Lake Okeechobee |L64 East South Florida Water - 4382 No |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations
|and maintenance
SOUTH | JACKSONVILLE Region |Florida- 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water - 49459 No |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeschobee County, Watershed Management District constructed, tumed over to
Saint Lucie County | public sponsor operations
|and maintenance
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Figure 4-30: Actions Menu Functions

1. Click on the “Actions” button

2. Click on “Reset.” A reset region will display as shown in Figure 4-31: Actions Menu - Reset

US Army Corps of Engineers
(Gl Maps Help AboutNLD Contact Us
Segment Detail Report

B =
A

(49) Reset

Restore report to the default settings.

4 [Appy<— 3

Division ~ Organization ::g"?; ;g;lg't State(s)  County(ies) ' C ‘T’éﬁem Seg:gm p  SystemName  SegmentName Sponsor(s)
SOUTH | JACKSONVILLE Region |Florida-23 Florida | Broward County, 3405000037 3404000024 Western EAA |L-1 East South Florida Water
ATLANTIC 04 Hendry County, Palm Management District

Beach County

SOUTH | JACKSONVILLE Region |Florida - 23 |Florida | Palm Beach County 3405000038 3404000025 L-8 West, L-10 and :;L-10 South Florida Water
ATLANTIC 04 - Management District

Figure 4-31: Actions Menu - Reset

3. Click the “Apply” button to reset report to the default settings
4. Click the “Cancel” button if you do not want to reset report

4529 Help

The “Help” option in the actions menu provides a detailed explanation on the Interactive Reporting functions.
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Loy

Home LGVl Maps Help AboutNLD Contact

Segment Detail Report 1
N &
A
- Select Columns
. FEMA  Cong. FC Design  Design  Engineer Segment Length  Risk
S e R VF"‘” Egnentip] " SYSIEMNANe | Sequient Nae - SpOnSON) =i Fquency [ NEP Date]| NFP™ | oo ey | Assignmert
SOUTH | JACKSONVILLE Region |Florida- 23 Floida |~ Rows Per Page ¥ 404000024 Westem EAA L1 East South Florida Water - 550 - - -en No
ATLANTIC 0 L Management District
=={Format »
SOUTH | JACKSONVILLE Regin Florida-23  Florida | 404000025 L8 West, L-10and  |L10 South Florida Water 4600 450 - - 4101726 No
ATLANTIC 04 ’ Reset L12 Management District
—
'SOUTH  JACKSONVILLE Region  Florda- 16, Florida 9 He\pe 2 000134 NE Lake Okeechobee  L65 East South Florida Water - - - - 691%  No
ATLANTIC 04 Florida - 23 Watershed Management District
Wannload
SOUTH | JACKSONVILLE Region  Florida - 16, Florida " o ~smsaweasar-s404000135 NE Lake Okeechobee |L64 East South Florida Water - - - <4382 No
ATLANTIC 0 Florida - 23 Okeechobee County, Watershed Management District
Saint Lucie County
SOUTH | JACKSONVILLE Region |Florida- 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Flrida Water - - - - 49459 No
ATLANTIC 3 Florida - 23 Okeechobee County, Watershed Management District
Saint Lucie County

Mg National Levee Database
i

o Feedback ] Logn

1-500f 3247 )

Authorization Type

|USACE Federally

constructed, tumed over to
public sponsor operations

|and maintenance

USACE Federally

|constructed, tumed over to
| public sponsor operations
|and maintenance

USACE Federally

constructed, tumed over to
public sponsor operations

and maintenance

|USACE Federally
|constructed, tumed over to

public sponsor operations

|and maintenance

|USACE Federally
|constructed, tumed over to
|public sponsor operations
|and maintenance

Corps
Program
Levee
Yes

Yes

Yes

Figure 4-32: Actions Menu Functions

1. Click on the “Actions” button

2. Click on “Help.” A help region will display as shown in Figure 4-33: Actions Menu -
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45.2.10

The Download option in the actions menu allows you to download the current result set of the report into an

Interactive Report Help

Interactive report regions enable end users to customize reports. Users can alter the layout of report data by selecting columns,
applying filters, highlighting, and sorting. Users can also define breaks, aggregations. charts, group bys. and add their own
computations. Users can also set up a subscription so that an HTML version of the report will be emailed to them at a designated
interval. Users can create multiple variations of a report and save them as named reports, for either public or private viewing.

An interactive report can be customized using the Search bar, Actions menu, or Column Heading menu. To learn more, see
"Customizing Interactive Reports” in online Help.

Search Bar

At the top of each report page is a search region. This region (or Search bar) provides the following features:

* Select columns icon enables you to identify which column to search (or all).

* Text area enables you to enter case insensitive search criteria (wild card characters are implied).
® Go button executes the search.

* Reports displays alternate default and saved private or public reports.

* Actions Menu enables you to customize a report. See the sections that follow.

Actions Menu

The Actions menu appears to the right of the Go button on the Search bar. Use this menu to customize an interactive report.

Select Columns

Used to modify the columns displayed. The columns on the right display. The columns on the left are hidden. You can reorder the
displayed columns using the arrows on the far right. Computed columns are prefixed with .

Filter

Focuses the report by adding or modifying the WHERE clause on the guery. You can filter on a column or by row.

If you filter by column, select a column (it does not need to be one that displays), select a standard Oracle eperator (=, =, not in,
between), and enter an expression to compare against. Expressions are case sensitive. Use % as a wild card (for example,
STATE NAME like A%).

If you filter by row, you can create complex WHERE clauses using column aliases and any Oracle functions or operators (for
example, G = 'VA' or G = 'CT', where Gis the alias for CUSTOMER STATE).

Rows Per Page
Sets the number of records to display per page.
Format

Format enable you to customize the display of the report. Format contains the following submenu:

Sort

Control Break
Highlight
Compute
Aggregate
Chart

Group By

Sort

Figure 4-33: Actions Menu - Help

Download

Excel CSV file.

28

30-JUN-2015



NLD User Manual United States Army Corps of Engineers

...... National Levee Database
=2 e =
H .
US Army Corps of Engineers P
Home ELGIGH Maps Help AboutNLD Contact Us
Segment Detail Report 1
N
"
5 Salect Calumns 1-500f3247 )
FEMA  Cong FC Desgn Design  Engineer Segment lengh  Risk S
DA OGN0 P i S ] V e qnentip| ~ Systembane, | Segnenthane - SpOSOS) |y rerieney | NFP Date| NEIP 11 Mies) | Assignment| ~ Autorzaton Type P[‘::f"
SOUTH  JACKSONVILLE Region Florida-23 Florida | ~{Rows Per Page ¥ 404000024 Westem EAA |l East South Florida Water 550 - - 8737 No iUSACE Federally Yes
ATLANTIC 04 & Management District constructed, tumed over to
I Format ) public sponsor operations
| B | and maintenance
SOUTH  JACKSONVILLE Region  Florida-23 Florida 404000025 L-8 West, L-10and L0 South Florida Water 4600 440 - 4 104726 No  |USACE Federally Yes
ATLANTIC 04 - Management District constructed, tumed over to
public sponsor operations
| | and maintenance
SOUTH  JACKSONVILLE Region  Florida- 16, Florida 404000134 NE Lake Okeechobee  L65 East South Florida Water - 691%  No  USACE Federally Yes
ATLANTIC o Florida- 23 Watershed Management District constructed, tumed over to
public sponsor operations
2 and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida NE Lake Okeechobee |L64 East South Florida Water 4352 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Watershed Management District constructed, tumed over to
Saint Lucie County public sponsor operations
| and maintenance
SOUTH | JACKSONVILLE Region  Florida - 16, Florida  Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East  South Florida Water - 49459 No  |USACE Federally Yes
ATLANTIC 04 Florida - 23 Okeechobee County, Watershed Management District constructed, tumed over to
Saint Lucie County | public sponsor operations
|and maintenance

Figure 4-34: Actions Menu Functions

1. Click on the “Actions” button
2. Click on “Download.” A download region will display as shown in Figure 4-35: Actions Menu -
Download

Army Corps of Engineers

Lol Maps Help AboutNLD Contact

Segment Detail Report

A
ﬁDownload

Choose report download format:

3

csv
5 S FEMA Cong. 5 FC System FC Design  Design
Division Organization e | State(s| County(ies’ System Name I ment Name Sponsor(s;

9 Region  District ) ty(ies) D Segment ID Y Beg po ) Flow = Frequency
SOUTH JACKSONVILLE Region Florida-23 Florida  Broward County, 3405000037 3404000024 Western EAA |L-1 East South Florida Water 550
ATLANTIC 04 Hendry County, Palm Management District

Beach County

SOUTH JACKSONVILLE Region Florida-23 Florida | Palm Beach County | 3405000038 3404000025 L-8 West, L-10 and L-10 South Florida Water 4600 450
ATLANTIC 04 - Management District

Figure 4-35: Actions Menu - Download

To download the report to Excel CSV, click the “Excel CSV”” icon. You will be given the option to open

or save the file. Choose to open the file to store in a temporary location on your computer, or save it to

specify the location of the file

45211 Using Interactive Columns
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In addition to creating an interactive report within a standard report results list, an interactive report can be

created within a column of the results list.

Segment Detail Report

1 L 4 Go Actions
Division = Organization §|EZ. 31 & g [[state® County(ies) S SIéStem Seg;gnt o SystemName  SegmentName Sponsor(s)
SOUTH (a_& = Florida  Broward County, 3405000037 | 3404000024 Western EAA L-1 East South Florida Water
ATl A Hendry County, Palm Management District
\ % 6 Beach County
ALASKA da | Palm Beach County 3405000038 3404000025 L-8 West, L-10 and L-10 South Florida Water
C | ALBUQUERQUE - Management District
BALTIMORE ‘5
SOUTH BUFFALO Florida | Martin County, 3405000067 | 3404000134 NE Lake Okeechobee |L65 East South Florida Water
ATLANTIC |CHICAGO Okeechobee County, Watershed Management District
DETROIT Saint Lucie County
SOUTH | FORT WORTH Florida  Martin County, 3405000067 3404000135 NE Lake Okeechobee |L64 East South Florida Water
ATLANTIC |GALVESTON Okeechobee County, Watershed Management District
HONOLULU Saint Lucie County
SOUTH FULHLICIRe Florida | Martin County, 3405000067 3404000136 NE Lake Okeechobee |L63 South East | South Florida Water
ATLANTIC |JACKSONVILLE Okeechobee County, Watershed Management District
KANSAS CITY -~ Saint Lucie County
Figure 4-36: Actions Menu Interactive Columns Report

The basic functions of interactive reporting within a column heading include the following:

1. Column Header: Allows you to click the column header within a results list to display the interactive

reporting capabilities

wn

Sort Ascending/Descending: Allows you to sort column results list in ascending/descending order
Hide Column: Allows you to hide column from results list

4. Control Break: Allows you to display data, broken out and grouped based upon the values within the

selected column

o

Column Information: Gives a short description/definition of the column

6. Search Field: Allows you to enter a keyword to search for and filter data within the column

4.6 Find Levees Near Me

This reporting feature allows you to identify levee data based upon zip code and then display levee systems on

the NLD’s interactive map.
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‘l:“'
Corps of Engineers
Home BGLNiCM Maps Help AboutNLD ContactUs

Find Levees Near Me

Zip Code > 1

Distance miles

2 #:.mM Return to Report Store. |

Figure 4-37: Find Levees Near Me

1. Enter the “Zip Code” and “Distance”
2. Click the “Submit” button

.aS,‘[ 1L T T |
» ’m’;‘ e National Levee Database

| US Arm

y Corps of Engineers Tm——

®
Home EGCE Maps Help AboutNLD ContactUs
Find Levees Near Me
Zip Code 63130
Disance 30 miles
submit | Retur o Repor Store |
() b
/ 3 4
e 1-320f32
FEMA Length | Linkto ifpection lnspection. Risk COPS | | oveeq Avea
System Name: Cong. District |~ State County Regon’ | Mies)”| Wap, |/ Tipe ? Inspection Rafing e | Aesignent Authorization Type } PL;ug:m Tie
’)'LabadieBmmmLevee Section 4 Missouri-09  |Missouri|Franklin County |Region 7 1 48674 ° "Routine ACCEPTABLE 01APRI0 | Mo Non-federally constructed, operated and maintained by locals o Agricultural
/
 |MESD/ Chain of Rocks East ~llinois - 12, llinois Madison County, ~ |Region § Z 35017 . Periodic | UNACCEPTABLE ~ 22-MAY-10 No USACE Federally Constructed and USACE Federally Operated, USACE  Yes Urban
/) Levee System llinois - 19 Saint Clair County Federally constructed, tued over to public sponsor operations and
maintenance
“ Monarch Chesterfeld Levee  Missouri-02 | Missouri Saint Louis County | Region 7 1| 12029 ) T 5 - No  Nondederally constructed, operated and maintained by locals No Rural
/" |District System
’) arth City Levee District System Missouri-01 | Missouri|Saint Louis County  |Region 7 1 25137 6 - - - No Non-federally constructed, operated and maintained by locals No Agricuttural |
’:) Brevator Levee System Missouri-02  |Missour Lincan County ~~ [Regon7 | 1| 6262 | @ - 2 s No  Nondederally constructed and O&M, in USACE RIP Yes
; |

Figure 4-38: Find Levees Near Me Results

3. Alist of levees will populate within the distance of the zip code entered
4. Clicking the “Link to Map” icon will display the levee system on the interactive map
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LY k
US Army Corps of Engineers

Welcome to the National Levee Datab%as

The National Levee Database (NLD), developed by the U.S. Army Corps of Engineers (USACE), is the focal point for comprehensive information about our nation's levees. Authorized by
Congress in 2007, the database contains information to faciltate and link activities, such as flood risk communication, levee system evaluation for the National Flocd Insurance Program
(NFPP), levee system . flood plain manag and risk The NLD continues to be a dynamic database with ongoing efforts to add levee data from federal
agencies, states, and fribes.

Here is what is available in the NLD:
o Majority of levees located within the USACE Levee Program
Reports on levees in the NLD located within your state, zip code, or address
Various federal database resources integrated into NLD such as the National Weather Service
Feedback link for you to provide comments on the NLD

.
» Contact Us tab if you need assistance or have questions

Maps
Search and view levees
using the interactive map

About NLD
View presentations,

A Please Note: The NLD currently contains the majority of levees within the USACE program. The
NLD does not contain all levees located in the United States.

Reports

on the rollout of
the NLD

National Levee Database

1. Feedback ] Login

;(0uCl Reports Maps Help AboutNLD ContactUs

Help

Download user manuals,
quick guides and videos on s
how bestto use the NLD

Contact Us [==—
Please contact us for |
assistance with the NLD. \

View searchable reports depicting levee system and segment information

Advanced Reporting
Navigate through customized reports

Basic System Reporting
Search for NLD levee data by specified search criteria \

Find Levees Near Me

Zip Code
Distance miles

Submit

@

—

Figure 4-39: Find Levees Near Me

5. Enter a zip code and distance and click “Submit” in order to generate a Find Levees Near Me report

directly from the Home tab
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S.

Plots

From the System Feature and Segment Feature reports, the user may navigate to the feature drilldown reports to
view detailed information about a specific feature type of the system or segment. For both the Cross Section
line and Closure Structure line a profile plot is available for viewing:

I

Division

SOUTH PACIFIC

SOUTH PACIFIC

SOUTH PACIFIC

SOUTH PACIFIC

Segment Feature Report %
e

(e

Maps

EMA  Cong.

‘Organization

SACRAMENTO Region 9 | California -
02

SACRAMENTO Region 9 ‘Callfornla -
n

SACRAMENTO Region 9 | California -
10

=

Region(s) District(s)

SACRAMENTO Region 9 | California -
02

California

California

California

California

Help

Actions

Sutter County

Butte County,
Glenn County

About NLD Contact Us

Interceptor Canal
- Unit 2, east
canal

Maintenance
Area 05 - Unit 1,

Butte Creek left
bank - Part 1
San Joaquin Bear Creek - Unit
County 8, Bear Creek left
bank above
Mosher Creek
Sacramento RD 0341 -
County Sherman - Unit

2, Sacramento
River

I

I~

Closure = Cross
State(s) County(ies) Segment Name Centerlines Structure Section

Lines
0

Lines

Flooawall 2

Drain  Drain
Lines | Lines
1 0

2

Lines
5 0
0 0
0 0
5 0

Points
0]

T
°°  Borenole Crossing Encroachment

Points
2

&

&

National Levee Database

Points

Pump  View
Station  RIP
Points History
0 0 |View

& Feedback

| Login

1-500f3081 »

Authorization
Category

USACE Federally
constructed,
turned over to
public sponsor
operations and
maintenance
USACE Federally
constructed,
turned over to
public sponsor
operations and
maintenance
USACE Federally
constructed,
turned over to
public sponsor
operations and
maintenance
USACE Federally
|constructed,
turned over to
public sponsor
operations and
maintenance

Figure 5-1: Segment Feature Report — Cross Section Lines

1. Navigate to the System Feature Report or the Segment Feature Report
In the Cross Section Lines column, click the hyperlinked value to view the cross section lines for the
selected segment

2.

~
7

Organization

SACRAMENTO Interceptor Canal -
ast

SACRAMENTO Interceptor Canai -
East

SACRAMENTO Intercaptor Canal -
East

SACRAMENTO | Interceptor Canal -
East

SACRAMENTO Interceptor Canal -
East

Cross Section Lines

Segment
Interceptor Canal -
canal
Interceptor Canal -

System Name

Interceptor Canal -
canal
Interceptor Canal -

Interceptor Canal -
canal

Return to Segment Feature

Name
Unit 2, east

Unit 2, east
Unit 2, east
Unit 2, east

Unit 2, east

§ Arfﬁy Corps of Engineers

3Gl Maps Help AboutNLD Contact Us

Sponsor(s)

Central Valley Flood Protection

Board

Central Valley Flood Protection

Board

Central Valley Flood Protection

Board

Central Valley Flood Protection

oard

Central Valley Flood Protection

Board

Coordinate Capture Linkto | View
Method Map Plot
Surveyed using RTK GPS @ (Ve
Plot
Sul RTK GPS View
4 ®
Sul RTK GPS View
®
Surveyed using RTK GPS 0 iew
Plot
Surveyed using RTK GPS @ Vv
Plot

View Survey
Media
07-NOV-07
15-APR-08
15-APR-08

River

Mile

National Levee Database

Horizontal Accuracy
(Feet)

03

03

03

08

.08

Vertical Accuracy
(Feet)

& Feedback

& Login

Levee Stationing
Code

03~

03~

03-

Figure 5-2: Cross Section Lines — View Plot

3. Click “View Plot’ for a cross section to view the profile plot
4. You can also click the ‘Link to Map’ icon to view your point on the map
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National Levee Database

i b
SFeedvack ] Login

§Arm;( Corps of Engineers

3 Reports [ET.13

Cross Section Plot

5 % Segment Name: Interceptor Canal - Unit 2, east canal

Cross Section ID: 5218108001

B2 Etevations (NAVDSS)

Elevation (Feet - MSL)

Total Distance (Feet)

5. The Cross Section Plot will display, identified by the Segment Name and Cross Section 1D
6. Click ‘Export Plot Coordinates’ to view the plotted coordinates, by elevation and distance, in Excel

Figure 5-3: Cross Section Plot

Repeat the above steps to view the closure structure plot, from the Closure Structure Lines report.

Note: the Cross Section Plot and Closure Structure Plot will not display if there is no information regarding the
feature’s elevation.
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6. Maps

6.1  Navigating to Maps

The “Maps” tab is the third tab available on the NLD navigation toolbar.

US Army Corps of Engineers

Home

National Levee Database

4

1

Maps

the interactive map

Search and view levees using ( I:

SMOUSR Feetback umpx

Reports Maps Help Feedback AboutNLD ContactUs
Welcome to the National Levee Database 2

Help ;:
Downlozd user manuals ;
quick guides andvideos on 4

how bestto use the NLD

PageE 4

About NLD Contact Us
Please contactus for ==
% SN Lo = % % documents on the rollout of assistancewiti e NLD. | <
A Please Note: The NLD currently contains the majority of levees within the USACE program. The NLD does not contain all levees located in the United | et L
States.
Reports
tem and
Basic System Reporting Advanced Reporting = Find Levees Near Me Vo
Search for NLD levee data by specied search criteria Navigate through customized reports ‘O ZipCode @
\/\ Distance miles -
Submit

Figure 6-1: Maps Tab

1. The user can click on the “Maps” tab to navigate to the interactive map
2. Clicking the “Maps quick-link button will also navigate to the interactive map

By clicking on either of these two “Maps” options you will be taken to the Maps screen shown below in Figure

6-2: Maps.

35

30-JUN-2015



NLD User Manual United States Army Corps of Engineers

National Levee Database

orps of Engineers TE—

Help AboutNLD ContactUs

C3 S % querytayer:| || No query Layer |# BaseMap~ Scale: 1:27,734,017~

% =+ & Find aLayer
Z]Non-USACE Levees

» DENwD

 [_JUSACE Civil Works

» [_JESRI ArcOnline Services

» [JReal Time Weather

© (ZJPrecipitation Accumulation

v (JFederal

© [ZINon-Federal

v [Z)Imagery

© [LINRCS Web Services

© [Z]US FWS Web Services

Print Map RI AROff ~

Figure 6-2: Maps

The Map navigation tools include:

1. Zoom in/ Zoom out
2. Pan
3. Previous / Next view

All map tools contain “tool tips” which is identified by hovering the cursor over each toolbar item. A small pop-
up box will display next to the curser that contains supplementary information regarding each item.

6.2  Map Utilities

Five BaseMaps are included in the map utilities; four Google maps (Hybrid, Streets, Satellite, and Terrain) and
a USGS DRG Topographic map layer.

C3 D O querytayer:| |v| Nouery Layer | | scale: 1:27,734,017+
Google Hybrid

Wa aa@ oo slireaad x

= Columbia.
=)

L o 9. " Google Streets
Bloe ] » ; o
T eI 2 Google Satelite
] Google Terrain
[Levee Borehole - a ATy OpenStreetMap
Levee Centerline : rof : £ . USGS Topos

[¥]Levee Closure Structure

Levee Station
Levee Toe Drain

© (ZJUSACE Civil Works

» (_JESRI ArcOnline Services

» (JReal Time Weather

© [_Precipitation Accumulation
» (LFederal

» (ZINon-Federal

» (JImagery

© [ZJNRCS Web Services

» (Z]US FWS Web Services

Search - Sea, | Map daia €2013 Basarsof, Google, INEG), MapLink, ORION-HE - Terms of Use
Print Map RI AROff ~ SVOff ~ OVOff ~ TFOff ~ CS+ Distr Area~ No QueryLayer -28.64209, 50.21963 LL (WGS84)

Figure 6-3: BaseMap Utilities
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1. Click on the dropdown arrow in the “BaseMap” box to select a basemap

3 @ ‘t,wgymen] .| No Query Layer P BaseMap~ |{

3,386
6,771
13,542

ZINon-USACE Levees Yreh
PT= Yy ¥y Sow : . 27,084
[[Levee Borehole s ‘ ¢ 54,168
[]Levee Centeriine %t o ; 108,336

[7]Levee Closure Structure
216,672

433,344
Levee Encroachment d s i 866,688
[¥]Levee Flood wall 1,733,376
Levee Gravity Drain
i 3,466,752

6,933,504

Levee Pump Station
evee Rehabilitation
evee Relief Well
evee Station

13,867,009
27,734,017
55,468,034

evee Toe Drain
© [Z]USACE Civil Works
© (LJESRI ArcOnline Services
© (LJReal Time Weather
» (JPrecipitation Accumulation
» (JFederal
» (ZJNon-Federal
» (JImagery
© [ZINRCS Web Services
© [ZJUS FWS Web Services

Legend
Search
Print Map

[B) Google  ap dta @201 Basarsot, Gaoge, NEG) MapLink, OROIHE ’

RI AROff ~ SVOff - OVOff ~ TFOff ~ CS~ Distr Area~ No QueryLayer |-28.64209, 52.46991 LL (WGS84)

Figure 6-4: Map Scales

2. Click on the dropdown arrow in the Scale box. You can set the map to a fixed scale. The fixed scale
choices are based on Google map tile scales

QJQQE\GQ\GIE‘R'“&@ ! [NoQueylaer  |P|BaseMap~ Scale: 1:27,734,017

[[JLevee Borehole
[V]Levee Centerline
[¥]Levee Closure Structure
[evee Crossing
Levee Cross Section

evee Pump Station
evee Rehabilitation

© (ZJUSACE Civil Works
© [LJESRI Arconline Services

© (ZJReal Time Weather

© [ZJPrecipitation Accumulation
» (IFederal

© (ZINon-Federal

» (ZJImagery

© [ZINRCS Web Services

» [ZJUS FWS Web Services

@ Acres

Hectares
Sq Feet

Legend o Sq Meters.
el ! N savies
Print Map OVOff » TFOff - CS~ Dist~ | No Query Layer |-49.29639, 13.81756 LL (WGS84}

]

Figure 6-5: Area Units

3. Click the dropdown arrow in the “Area” box. Unit of measures are available for linear and area
measurements

6.3 Search

You can search for a location on the map by any of the following five search methods: Coordinate, Address, Zip
Code, County or Google Search.
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ala Qg\ QO lmlRReoo&d X [Iw[Noqueryiaver " |P|BaseMap~ Scale: 1:27,734,017 -

A
Legend
Search
County -
State Calfomia v
County Sacramento
[ Submit ]
2
Google RN €0 " lap ot 2013 asarso, Google, NEG apLnk, OROILE - Terns o s}
Print Map [+ | Map Ready RI AROff ~ SVOff - OVOff ~ TFOff - CS- Dist~ Area~ NoQueryLayer -39.27686,32.67708 LL (WGS84)|
g

Figure 6-6: Search for Location

1. Select method of Search (Coordinate, Address, Zip Code, County or Google) and enter relevant
information
2. Click the “Submit” button

Layers
Legend N
Search > % 2 -
Name ’ : WL p £
Sacramento N - I
"‘\ : £, .‘ T B som 5 /1
Print Map @ Map Ready RI AROff + svoff - ovoff ~ TFOff + CS~ Dist~ Query Layer -120.51257, 74725 LL (WGS84)|
1

Figure 6-7: Search for Location

3. The system will display a link to confirm the search criteria. Click on the link and the system will put a
pin on the map and zoom in to that location

6.4 Layers

The layers are located on the left panel of the map.
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rps of Engineers S

Home Reports QUCTEM Help AboutNLD ContactUs

B oo wligeaz %8 & T Quen Layer:
J ‘E AN >
Layers |28 i
%5+ 2 Finda Layer ;
| EINon-USACELevees
B~ m|n )

["]Levee Borehole
[7]Levee Centerline
[V Lexg Closure Structure
Levde Ohsging
[Cevee Cross Sestion

(] Levee Encroachment
vee Flood Wall
vee Gravity Deer

hesPreTometer

<ed Area
[[Levee Pump Station
[TlLevee Rehabilitation
[Tlievee Relief well
Levee Station
Levee Toe Drain

» [ZJUSACE Civil Works

» [_JESRI ArcOnline Services

© [JReal Time Weather

» (_Precipitation Accumulation

» [LJFederal

» (ZINon-Federal

> (JImagery

» [ZINRCS Web Services

(Z1US FWS Web Services

Legend *)
Search i Google
Print Map Map Ready

Figure 6-8: Map Layers

1. Click the “Layers” bar to expand the layer panel
2. Turn on individual layers by selecting the associated checkboxes

Note: The following layers will display by default: Levee Centerline, Levee Closure Structure, Levee Flood
Wall and Leveed Area.

Layers
4 IFederal
» (Z1Bureau of Reclamatiof
> (CJEPA
» (L) National Atlas
acInoAA
treamgages Observed

Google

Terms ot s

[ | Map Ready RI AROff ~ SVOff - OVOff ~ TFOff - CS~ Distw Area~ No QueryLayer -119.86575, 38.96836 LL (WGS84)|

&)

Figure 6-9: Multiple Map Layers

3. Expand the layer folder to see additional layer options and select multiple layers
4. Select the sub-layers by clicking the check boxes of the ones you want to display

To search the layers panel, enter the search criteria into the text area ‘Find a Layer.” Results will display as text
is entered.
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oo < ) ; e ‘ 9.0 mmmsam.,- Scale: 1

Layers

% & @[ fooa ]

4 Ino
[¥]Levee Flood wall
4 JFederal
43 Bureau of Reclamation
[TLevee Flood wall
4 JNOAA
4 [streamgages observed
[“Imajor Flooding
[ Minor Flooding
No Flooding
o [[lstreamgages Forecast
4 INon-Federal
4 3 Miami Conservancy District
[Tievee Flood wall

Legend o
Search Bl Google pr——
Print Map [+ Map Ready SVOff - OVOff ~ TFOff = CS~ Dist~ Area~ No QueryLayer -119.46750, 81872 LL (WGS84)|
(]
Figure 6-10: Find a Layer
6.5 Legend
The legend panel will help you decipher the various symbols generated on the map when displaying different
layers.

Levee Centerline

N Levee Centerline

Levee Closure Structure
A/ Closure Structure

Levee Flood Wall

N Flood Wall

Leveed Area

[ Leveed Area

Search

57

Roseyille

Print Map

Figure 6-11: Legend

6.6

1. To access the legend, click on the “Legend” panel in the left hand navigation. The legend will only
display the layers that have been selected in the “Layers” tab

Print Map

To view or print a PDF Map, open the Print Map panel.

1. Drag and resize the highlighted area on the map to select the region to be printed
2. Enter atitle and comments, and select a layout, resolution, scale and rotation, if desired

3. Click ‘Create PDF’ and the map will display in a separate window
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6.7  Queries

Figure 6-12: Print Map

A Al Leveed Areas are approximate.
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Figure 6-13: Queries

A user can query “Levee Centerline,” “Levee Flood Wall,” “Levee Closure Structure” and “Leveed

Area” features on the map. To query one of these layers, it must be turned on in the layers panel

N
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-OR-

4. Click the single conversation box tool titled “Popup Info Query.” After clicking the tool, you will be
able to draw a red square on the map. The square you draw will determine the area that will be queried
and a popup will display the results

5. Click the double conversation box tool titled “Table Info Query.” After clicking the tool, you will be
able to draw a red square on the map. The square you draw will determine the area that will be queried
and a table will display the results under the map
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Figure 6-14: Popup Query Results
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Figure 6-15: Table Query Results
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6. Click on any of the System Name links to navigate to the System Detail report for the selected system
7. Click on any “Yes” values in the Risk Assignment column to navigate to the Detailed Risk Report for the selected
system

6.8  Additional Map Tools
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Figure 6-16: Additional Map Tools

1. Get Address at Point Click

To use the ‘Get Address at Point Click’ tool, click the icon in the Map navigation toolbar; the cursor will be replaced with
a crosshair surrounded by a circle. Click on the map, and an Address Results dialog box will display with information
about the selected location.

2. Get Elevation Profile
The “Get Elevation Profile’ tool provides a charted profile of the elevation of the line drawn on the map. Select the tool in

the Map navigation toolbar; the cursor will be a crosshair surrounded by a circle. Click on the map to start drawing a line.
Single click to add a point on the line, and double click to stop drawing the line and view the profile in a dialog box.

3. Distance / Area Measurements

The distance and area tools provide the capability to measure area and distance. To change the units the distance or area
will be returned in, select the ‘Dist” or ‘Area’ menus from the bottom of the map toolbar. Select the Measure Area icon or
the Distance icon from the toolbar along the top of the map. Click on the map to begin digitizing. The line or polygon will
define the area that is measured. Once complete, double click. The area and distance box will populate the measurement
results.

4. Clear Current Measures

43

30-JUN-2015



NLD User Manual United States Army Corps of Engineers

Click the ‘Clear Current Measures’ icon to clear any measurements from the map in order to generate another
measurement.
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7.

7.1

Feedback

Submit Feedback

The feedback function allows you to submit feedback on any screen within the tool. The purpose of the

feedback function is to enable all users to provide instantaneous input about the functionality of the application
on any given screen.

The feedback function can be used:

When there is an issue with the way the screen should work (e.g. “Nothing happened when | clicked on
the Submit button.”)

To make a suggestion for functionality in future versions of the tool. (e.g. “It would be beneficial to
have a field on this screen displaying the date that the document was reviewed.”)

The page numbers are located on the bottom of each page (screen) and unique for each page. Page numbers are
helpful to the NLD team to better relate feedback to a specific screen within the tool. As a result, it is
recommended to provide a Page number when feedback is provided.

National Levee D

& Feedback {5 Login

Figure 7-1: Feedback

To provide feedback about any portion of the NLD:

1.

Click the “Feedback” link in the upper right corner
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Figure 7-2: Provide Feedback Form
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2. This will trigger a popup to display where you can enter your name, email, and a description up to 2,000
characters
3. When you click the “Submit” button, your feedback will be recorded
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Appendix A — List of Acronyms

ASDSO Association of State Dam Safety Officials
CRREL Cold Regions Research and Engineering Laboratory
DoD Department of Defense

DRG Digital Raster Graphics

EM Engineering Manual

ERDC Engineer Research and Development Center
FC Flood Control

FEMA Federal Emergency Management Agency
FIRM Flood Insurance Rate Map

GIS Geographic Information Systems
HQUSACE Headquarters, U.S. Army Corps of Engineers
IEI Initial Eligibility Inspection

NAFSMA National Association of Flood & Stormwater Management Agencies
NLD National Levee Database

NMAS National Map Accuracy Standards

PAL Provisionally Accredited Levee

PDT Project Delivery Team

PGDB Personal Geodatabase

RIP Rehabilitation and Inspection Program
RS/GIS Remote Sensing/GIS Center

USACE United States. Army Corps of Engineers
USGS United States Geologic Survey

VPN Virtual Private Network
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